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Toolbars

Microsoft® Excel® toolbars offer convenient one-click access to the tools you use most often. 
Try these shortcuts to customize them to your preferences.

	 1.	 Add Macros into your toolbar. 

			   a.	 From the Menu bar select Tools, Customize.

			   b.	 Select the Commands tab. 

			   c.	 In the list of Categories, select Macros. 

			   d.	 The macro should then appear in the Commands list. 

			   e.	 In the Commands list, select Custom Button and drag the button onto the toolbar.

			   f.	 To assign the macro, select Modify Selection and select Assign Macro.

			   g.	 Select the desired Macro from the list and select OK.

	 2.	 Return your Toolbar to the default Microsoft Excel layout.

			   a.	 From the Menu bar select Tools, Customize.

			   b.	 Select the Toolbars tab.

			   c.	 Select the Toolbar you would like to reset.

			   d.	 Select Reset.

Think these tips  
are useful?  
Boost your Microsoft Excel 
expertise for use with Sage 
ERP MAS even more with  
free online training by  
Sage University.

Register today at  
http://sageu.com/MAS
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Navigating

You may navigate through your spreadsheets without much thought. These shortcuts offer 
you new, faster ways to access the data you need.

	 1.	 Navigate to different sheets in a workbook with many sheets.

			   a.	 Right-click on the sheet arrows at the bottom left of your screen.

 

			   b.	 A list of the sheets in the file will be displayed.

			   c.	 Left click on the sheet name you would like to navigate to. 

	 2.	 Learn two ways to select a row quickly.

			   a.	 Select the row number.

				    OR

			   b.	 Select any cell in that row and press Shift+Space bar.

PivotTable®

You can use a PivotTable report to summarize and analyze vital company data, you can use the 
following tips to learn a more efficient process for formatting these convenient summaries.

	 1.	 Maintain formatting when refreshing PivotTables. 

			   a.	 Format the PivotTable in whatever way you want.

			   b.	 On the PivotTable toolbar, select Table Options from the menu.

			   c.	 The PivotTable Options dialog box is displayed.

 

			   d.	 Make sure the Preserve formatting check box is selected.

			   e.	 Select OK.

Preserve 
Formatting

Sheet
Arrows
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	 2.	 The size of a file using Microsoft Excel software increases when a PivotTable®	
		  feature is included. Learn to reduce the file size. 

		  PivotTables by default always save the actual data with the layout of the table, and this 	
		  causes the increase in the size of the file. You can, however, change this on the table 	
		  options of the PivotTable. Once you have changed this, you will always have to refresh  
		  the table before you can use it. 

			   a.	 Right-click anywhere on the PivotTable.

			   b.	 Select Table Options from the shortcut menu.

			   c.	 Clear the checkbox toward the bottom of the options window “save data  
				    with table layout.”

			   d.	 Select OK, and then save the file. The file should have reduced in size.

	 3.	 Group your dates into Months or Quarters in a PivotTable. 

		  This can be easily done by using the Grouping feature in the PivotTable.

			   a.	 Select the field (Date) you wish to group.

			   b.	 Right-click and select Group and Show Detail.

			   c.	 Select Group.

			   d.	 The grouping dialog box appears, displaying dates and times.

 

			   e.	 Type the starting and ending information in the fields provided.

			   f.	 Select the option you wish to group by in the By list. 

			   g.	 Select OK.

			   h.	 Group dates will only work if you do NOT have blank cells selected in the source 	
				    data. If you do have blank cells selected, please reselect the area.

Save data with 
table layout
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Functions

Excel software functions allow you to create your own formulas, format data in multiple cells, 
and perform complex calculations of your data. Here are several functions you may not be 
aware of that can simplify your work processes.

	 1.	 There is a function in Excel called “weeknum” that determines the number of the 	
		  week within the year. This is not a standard function; it is only available if you use  
		  the Excel Add-Ins “Analysis ToolPak.” 

			   a.	 Select the Tools menu.

			   b.	 Select Add-Ins. The add-ins box will display.

			   c.	 Select the check box next to Analysis ToolPak.

 

			   d.	 Select OK.

			   e.	 The function Weeknum should now be available in the data and time category  
				    of functions.

	 2.	 If you have values in the cells D2 through to D1044, learn how to create a formula in 	
		  column E and quickly copy the formula from E2 through to E1044. 

			   a.	 Enter your formula into cell E3.

 

			   b.	 Place your mouse on the bottom right corner of cell E1 and double-click on the 	
				    Autofill handle.

			   c.	 The formula will then be copied down to cell E1044.

			   d.	 By double-clicking, it will automatically fill the range down to where there is data  
				    on the left in Column A. You can also use this for copying formula down.

Analysis  
ToolPak
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3.	 Count the number of cells containing data. 

	 Use the correct count function:

	 	 	 •	 Count: Counts the number of cells containing numbers, as well as numbers  
				    within the list of arguments.

	 	 	 •	 Count A: Counts the number of cells that are not empty, as well as the values 	
				    within the list of arguments.

	 	 	 •	 CountBlank: Counts empty cells in a specified range of cells

	 	 	 •	 CountIF: Counts using criteria

				    See screenshot below:

	 4.	 Calculate the number of months’ service for an employee. 

		  Use the “DATEDIF” function:

			   a.	 The date employed is in cell A2, and the current date is in cell B2.

			   b.	 Select cell C2 and enter = (DATEDIF(A2,B2,”Y”)*12)+DATEDIF(A2,B2,”YM”).

			   c.	 Format to number.

 

Think these tips  
are useful?  
Boost your Microsoft Excel 
expertise for use with Sage 
ERP MAS even more with  
free online training by  
Sage University.

Register today at  
http://sageu.com/MAS
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	 5.	 Separate a column of mixed positive and negative figures into two different columns 		
		  using the “IF” formula. 

			   a.	 In this example your data is in A2:A6.

			   b.	 In B2 enter the formula: =IF(A2>=0,A2,’’’’).

			   c.	 In C2 enter the formula: =IF(B2=””,A2,””).

			   d.	 Copy the formula down.

	 6.	 Format telephone numbers to look a certain way [such as 8668592378 to  
		  (866) 869-2378] by using a combination of Text functions. 

 

			   =”(“&”0”&LEFT(A14,2)&”)”&” “&MID(A14,3,3)&”-”&MID(A14,6,15)

		  Explanation:

			   a.	 In between the “ is the additional text such as - ( ).

			   b.	 The & symbol joins the items together.

			   c.	 LEFT extracts the first two digits (area code): 21.

			   d.	 The first MID is to extract from the third digit and three digits after that: 864.

			   e.	 The second MID is to extract from the sixth digit and 15 digits after that: 2603.

			   f.	 A14 is the cell with the original telephone number; if necessary, change that cell 		
				    reference of your first telephone number and copy the formula.

			   g.	 Simply copy and paste this formula to the relevant cell, ensuring you change the  
				    cell reference A14 to the cell your telephone number is in.
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	 7.	 Format a number without decimal places, with a thousands separator, and combine 		
		  it with text, using custom formatting and joining cells.

		  For example, Cell A1 contains “You owe” and cell B1 contains the value 87777.

		  In cell C1 enter the following formula =A1&” “&TEXT(B1,”R#,##0”).

	 8.	 Use a formula to calculate somebody’s age. 

		  Because a person’s age is the amount of time since birth, you can calculate age by 		
		  putting today’s date in one cell, the person’s date of birth in another cell, then taking the 		
		  date of birth away from today. Because you took a date serial from another date serial, 		
		  you actually get the number of days in between.

		  In this example the formula in cell A3 is: =A1-A2

 

		  We need to convert this number of days into a number of years. Most years have 365 		
		  days 	but every fourth year has 366 days. So the average number of years is 365.25.

		  In this example the formula in cell A3 is: =(A1-A2)/365.25

 

		  Note the parentheses around the first part of the formula. Parentheses mean “Work out 		
		  this bit first.” They are used to stop Microsoft Excel from trying to divide A2 by 365.25 		
		  before taking it away from A1. The number is now in years, but it’s still not quite right. 		
		  The result is accurate, but you don’t really want to see the fraction. As a last refinement 		
		  we’ll wrap the whole thing inside an INT() function to give us a whole number (an integer). 	
		  This is better than changing the number of decimal places displayed, which would risk 		
		  some numbers’ being rounded up and giving an incorrect result.

		  In this example the formula in cell A3 is: =INT((A1-A2)/365.25)
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	 9.	 Create your own Average IF function using a CSE. 

		  An array formula (CSE) can perform multiple calculations and then return either a single  
		  result or multiple results. Array formulas act on two or more sets of values known as  
		  array arguments. Each array argument must have the same number of rows and columns.  
		  You create array formulas in the same way that you create other formulas, except 	
		  you press CTRL+SHIFT+ENTER to enter the formula. You will notice that by using 	
		  CTRL+SHIFT+ENTER, it adds curvy brackets around the formula. This is what makes  
		  it a CSE formula.

		  Process: See the example below:
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Charts

If you use charts to bring your data to life, these tips can help to simplify their creation  
and maintenance.

	 1.	 Going through the ChartWizard can take a while. Learn to put a chart into your 		
		  workbook quickly.

			   a.	 Select the table on which the chart is to be based.

			   b.	 Press F11.

		  That’s It! Excel inserts a new Chart worksheet before the current worksheet and bases 		
		  the chart on the data in your table and the default chart type you have set up. At this 		
		  point you can perform whatever customization you like on the chart and work with it  
		  as normal.

	 2.	 Create a Chart that has both a line series and a column series plotted on the  
		  same Chart. 

		  If the Chart is already created:

			   a.	 Right-click on the chart you have created (on the chart area).

			   b.	 Select Chart Types.

			   c.	 Select Custom Types.

			   d.	 Select Line-column.

			   e.	 Select OK.

		  If you are creating a new Chart:

			   a.	 Select the area you would like to Chart.

			   b.	 Select the Chart Wizard button on the Standard toolbar.

			   c.	 Select the Heading tab, Custom Types.

			   d.	 Select Line-column.

			   e.	 Complete the rest of the Chart Wizard.

	 3. Using a Chart Title that is linked to your worksheet enables you to simply update your 	
		  worksheet, and your Chart Title will automatically update.

			   a.	 Create the chart as you would normally do.

			   b.	 Select the title you want to modify. Small handles should appear around the title.

			   c.	 In the formula bar enter the address of the cell you want to use for the title. For 	  
				    instance, if the title is in cell A5 of the Data worksheet, you would enter the 		
				    following in the formula bar: 

				    =Data!$A$6
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Filtering

Excel software offers the option of filtering your lists in order to access only the information 
you need. The following can help you create filters and extract data quickly.

	 1.	 Use filtering in Excel to filter a list quickly in order to summarize information. 

			   a.	 Select anywhere in the list.

			   b.	 On the Menu bar, select Data, Filter, Auto filter.

 

			   c.	 Use the drop-down arrows to filter your list.

	 2.	 If the same list of items is continually used, the easy way to insert the list without 		
		  having to retype it is using an AUTOFILL LIST. 

			   a.	 Select Tools, Options then select the Custom Lists tab.

			   b.	 Type the first item in the List Entries box and enter.

			   c.	 Type the rest of your items pressing enter after each one except the last one.

			   d.	 Select OK.

			   e.	 To use the list, enter any of the items in a cell then drag the cell’s Autofill handle 		
				    (bottom right-hand corner) down or across.

	 3.	 Extract a list of unique items from a list by using the Advanced Filter.

			   a.	 Select the worksheet where you would like the extracted list to appear.

			   b.	 On the Menu bar select Data, Filter Autofilter.

			   c.	 Select Copy to another location.

			   d.	 In the List range, select the list of items you are extracting unique records from.

			   e.	 In the Copy to field, select the first cell in the range where you would like to have 		
				    your results show.

			   f.	 Select the check box for Unique records only. Select OK.

Drop down 
arrow
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Formatting

Do you ever need to remove all of the spaces within a cell? Display numbers in a different 
format, or change a font type? You can do all of this and more simply by formatting your  
cells using the following steps.

	 1.	 Remove ALL spaces from a cell (as the TRIM function leaves one space in the 		
		  middle) using Find and Replace. 

			   a.	 Select the range of cells you would like to remove the space from.

			   b.	 Press Ctrl + H.

			   c.	 Click on the Find What box and press the space bar once.

			   d.	 Ensure the Replace with box has nothing in it.

			   e.	 Select Replace all.

	 2.	 If you receive data in one column and need to extract the data into different 		
		  columns, you can do this by using the “Text to Columns” wizard. 

			   a.	 Select the cells that contain the text or values. 

			   b.	 On the Menu bar, select, Data, Text to Columns, Next.

			   c.	 Select the Delimiter that separates the items.

			   d.	 Select Finish.

Think these tips  
are useful?  
Boost your Microsoft Excel 
expertise for use with Sage 
ERP MAS even more with  
free online training by  
Sage University.

Register today at  
http://sageu.com/MAS
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	 3.	 Change a font type to Sentence case by inserting VB code into the worksheet. 

			   a.	 Open the required workbook.

			   b.	 Right-click on any worksheet.

			   c.	 Select View Code.

			   d.	 On the left, select This workbook.

				    On the right side paste the below coding:

					     Sub TextIt_Click() 

					     ‘Modified Text converter 

					     ‘ Option to select range of cells or correct entire worksheet. 

					     Dim TextCaseAlch As Range 

					     Set TextCaseAlch = Selection.SpecialCells(xlCellTypeConstants, 2) 

					     For Each cell In TextCaseAlch.Cells 

					     s = cell.Value 

					     Start = True 

					     For i = 1 To Len(s) 

					     ch = Mid(s, i, 1) 

					     Select Case ch 

					     Case “.” 

					     Start = True 

					     Case “!” 

					     Start = True 

					     Case “?” 

					     Start = True 

					     Case “a” To “z” 

					     If Start Then ch = UCase(ch): Start = False 

					     Case “A” To “Z” 

					     If Start Then Start = False Else ch = LCase(ch) 

					     End Select 

					     Mid(s, i, 1) = ch 

					     Next 

					     cell.Value = s 

					     Next 

					     End Sub

	 4.	 Quickly format from one cell to a range of cells using FORMAT PAINTER. 

			   a.	 Select the cell or range that contains the formats you wish to copy.

			   b.	 Select the Format Painter icon (the yellow paintbrush icon on the Standard toolbar).

			   c.	 Click and drag the mouse over the range you want to paint. Excel then applies 		
				    the copied formats to the selected cells and automatically deactivates the painter.

			   d.	 If you need to copy formats to a range or multiple cells, double-click the Format  
				    Painter to keep it active. Pressing the Esc key deactivates the painter once finished.
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	 5.	 Force a new line within a cell. 

			   a.	 Press F2 to edit a cell.

			   b.	 Type the text you need on the first line.

			   c.	 Press Alt-Enter, and then type again. 

		  The contents of your cell are split onto two lines regardless of the width of the column. 		
		  Some people use wrap text to wrap the text onto two lines, but this is not a permanent 	
		  format since the text will adjust accordingly when you widen the column; you could 		
		  easily end up with the text on one line again.

	 6.	 Display numbers as only thousands or millions. 

			   a.	 Select the cell/cells to be changed.

			   b.	 Select Format, Cells, select the Number tab, choose Custom as the category, 		
				    then in the Type box, type in as follows:

				    for thousands enter #,
				    for millions enter #,,

			   c.	 Select OK.

FPO
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Conditional Formatting

Did you know you can answer specific questions about your data by highlighting cells based 
on a condition (or criteria)? Try these shortcuts to adding conditional formatting to cells to 
help you visualize data at a glance.

	 1.	 To apply conditional formatting to an entire row, fix your cell reference for  
		  the column.

		  You can apply conditional formatting that checks the value in one cell and applies 		
		  formatting to other cells based on that value. For example, you could color the entire 		
		  row in a table if the values in column E are over a set value (2000).

			   a.	 Select the cells to be formatted (A2:E).

			   b.	 From the Menu bar select Format, Conditional Formatting.

			   c.	 Enter the below and select OK:

 

			   d.	 In this example, the formula is =$E2>2000.

	 2.	 Compare two lists and identify the items that are different. 

		  This can be done by using a combination of Conditional Formatting and the COUNTIF 		
		  function. The first list is in A2:A16 and this range is named newacc. The second list is 		
		  in D2:D16, and the range is named oldacc. The ranges were named using the Insert  
		  – Name – Define Command. Naming the ranges is not necessary, but it makes them 		
		  easier to work with. As you can see, items in newacc that do not appear in oldacc 		
		  are highlighted with a blue background. Items in oldacc that do not appear in newacc 		
		  are highlighted with a purple background. These colors are the result of Conditional 		
		  Formatting. Select the newacc range.

!
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			   a.	 On the Menu bar, select Format, Conditional Formatting.

			   b.	 Enter in the below: =COUNTIF(OLDACC,A2)=0.

 

			   c.	  Select the oldacc range.

			   d.	 On the Menu bar, select Format, Conditional Formatting.

			   e.	 Enter in the below: =COUNTIF(NEWACC,D2)=0.

			   f.	 The COUNTIF function counts the number of times a particular value appears  
				    in a range. If the formula returns 0, it means that the item does not appear in  
				    the range. Therefore, the conditional formatting kicks in, and the cell’s 			
				    background color is changed.

	 3.	 Highlight duplicate items in a column. 

			   a.	 Select the range of cells.

 

			   b.	 On the Menu bar, click on Format, Conditional Formatting.

			   c.	 Under Condition 1, select Formula Is.

			   d.	 In the formula =COUNTIF(column range you are in, cell you are in)>1.

			   e.	 Select Format and select a Pattern of your choice.

  

			   f.	 Click OK.
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Shortcuts

The handiest tips and tricks are shortcuts that will simplify everyday Excel tasks so you  
can get started with your spreadsheets quickly.

	 1.	 Use the Shift key to close a number of open workbooks. 

			   a.	 Hold down the Shift key as you select File on the Menu bar. 

			   b.	 You will notice that there is a Close All option. 

			   c.	 Choose this, and all your workbooks are closed. 

			   d.	 You will, of course, be prompted to save changes on each open  
				    workbook, if necessary.

	 2.	 Quickly enter today’s date in a cell without having to type a formula.  

			   a.	 To enter the date press CTRL + ; (Ctrl and semicolon simultaneously).

			   b.	 To enter the time press CTRL+Shift+ ; (Ctrl, shift colon simultaneously).

 

	 3.	 Quickly insert a new worksheet.

			   a.	 Select the worksheet to the right of where the new worksheet will be inserted.

			   b.	 Press Shift+F11.

Page Setup

Ready to print? Use these shortcuts to create a watermark, apply a header and footer, 
establish print settings for multiple worksheets at once, and more.

1.	 To use the same printing settings for a number of worksheets, without having to 		
	 manually set up each worksheet, group the worksheets together. 

			   a.	 Select the worksheet whose print settings you want to copy.

			   b.	 Group this worksheet together with the worksheets that need to have  
				    the same settings.

			   c.	 From the File menu, select Page Setup, and then select OK.

			   d.	 The page settings from the worksheet selected in step a. are copied to all  
				    of the selected worksheets.

Think these tips  
are useful?  
Boost your Microsoft Excel 
expertise for use with Sage 
ERP MAS even more with  
free online training by  
Sage University.

Register today at  
http://sageu.com/MAS
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	 2.	 When you need to print different ranges for different departments in the same  
		  spreadsheet, create Custom Views so the settings don’t need to be redone every time. 

			   a.	 Before defining the print area, hide the rows and columns you do not want to 		
				    print, and set up the spreadsheet as desired.

			   b.	 From the View menu, select Custom Views. Select Add.

			   c.	 In the Add View dialog box, type the name of the view in the Name box,  
				    and then select OK.

			   d.	 Repeat until all different reports have been customized.

			   e.	 From any worksheet in the workbook, select the desired Custom View  
				    from the Custom View box.

			   f.	 Press Ctrl+ P. In the Print dialog box, click OK.

	 3.	 Use the “Remove Page Breaks” Function when the page breaks need to be reset.

			   a.	 Change your view to Page Break Preview.

			   b.	 View, Page Break Preview.

			   c.	 Right-click on any cell on the worksheet.

			   d.	 Select Reset All Page Break.

	 4.	 Create a watermark to have the word “Confidential” printed on  
		  Financial Statements and reports. 

			   a.	 Right-click on a toolbar and select the WordArt toolbar from the shortcut.

			   b.	 On the WordArt toolbar, select the Insert WordArt icon.

			   c.	 From the WordArt Gallery, select your choice of format, and then OK.

			   d.	 In the WordArt Edit Text dialog box, type Confidential, select the font and size, 	
				    and then select OK.

			   e.	 Right-click the WordArt, select Format WordArt from the shortcut menu,  
				    and then select the Colors and Lines tab.

			   f.	 In Fill, select No Fill from the Color dropdown list. 

			   g.	 In the line section adjust the color and line format to black.

			   h.	 Select OK.

			   i.	 Right-click the WordArt, select Order from the shortcut menu, and then Send to Back.

			   j.	 Adjust the WordArt to suit the sheet.

	 5.	 Apply the same Header and Footer to some of the worksheets on a workbook. 

			   a.	 Select the worksheets. If the worksheets are adjacent to one another, select the  
				    sheet tab of the first sheet in the range, hold the Shift key, then select the last 		
				    sheet in the range.

			   b.	 If the sheets are not adjacent to one another then select the first sheet, hold the 		
				    Ctrl key, select all other sheet tabs of the sheets you wish to apply the header  
				    and footer to.

			   c.	 Select File, Page Setup, Header and Footer.

			   d.	 Apply the header and footer.

			   e.	 To ungroup the sheets, hold the shift key then click on the first sheet tab  
				    within the group.
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	 6.	 When you click on a cell that contains a very long formula, it often takes up more  
		  than two lines of text in the formula bar and it hides the first rows of your 		
		  spreadsheet. To overcome this, insert a blank row at the top of the worksheet  
		  and increase the row height. 

			   a.	 To insert a blank row, right-click on Row 1, then select Insert, Rows.

			   b.	 Increase the row height of the new row by selecting, Format, Row, Height,  
				    then type in a high number (such as 50).

	 7.	 Display two worksheets in a workbook on the screen at the same time. 

			   a.	 Open the workbook; activate one of the worksheets you need to display.

			   b.	 Select Window, New Window.

			   c.	 The workbook will open a second time. In this workbook activate the second 		
				    sheet you need to display.

			   d.	 Now select Window, Arrange Windows.

			   e.	 Tick the check box “Windows of active workbook,” choose the display  
				    you want (tiled, vertical). 

			   f.	 Select OK.

	 8. Print the heading of a report on each page when it prints. 

			   a.	 Select File, Page Setup.

			   b.	 Select the heading tab Sheet.

			   c.	 In the “print titles” section, to have headings repeated; fill in the section  
				    “Rows to repeat at top.”

 

			   d.	 To have a column of information repeated on each page, fill in  
				    “columns to repeat at left.”

			   e.	 Select OK.

Rows to repeat 
at top

Sheet
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9. Match the name of a worksheet tab to a cell on the worksheet. 

			   a.	 Select, Tools, Macro, Visual Basic Editor.

			   b.	 On the left, in the Project window, select “This Workbook.”

			   c.	 On the right, in the Code window, paste the below code.

				    Private Sub Workshop_SheetChange(ByVal Sh As Object, ByVal Target As Range)

		  		  If Target.Address = “$A$1” Then Sh.Name = Target

				    End Sub

			   d.	 Select, File, Close and Return to Microsoft Excel.

Hyperlinks

If you use hyperlinks to jump from one workbook to another, these tips will come in handy.

	 1.	 Open another file from inside a workbook using a hyperlink. 

			   a.	 Select the cell where you want the link to be activated from.

			   b.	 Right-click and select Hyperlink.

			   c.	 Under Link To, select Existing File or Web Page.

			   d.	 Navigate to the desired file.

			   e.	 Select the desired file and select OK.

	 2.	 Select a hyperlink without activating it. 

			   a.	 Press and hold the mouse button on the cell for a few seconds.

			   b.	 To select a graphic with a hyperlink, CTRL and click the graphic.

Link To

Existing File  
or Web Page
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Excel Options

Set up your Excel system to work the way you want to. Use these tools to set additional 
preferences.

	 1. Show all the menu items, not only the recently used ones. 

			   a.	 Select Tools, Customize.

			   b.	 Select the Options tab.

			   c.	 Clear the check box “Menus show recently used commands first.”

			   d.	 Select OK.

	 2. Prevent Excel from prompting you to update links when you open a workbook that 		
		  contains links to other workbooks. 

			   a.	 Select Tools, Options.

			   b.	 Select the Edit tab.

			   c.	 Clear the check box Ask to update automatic links.

			   d.	 Select OK.

Sorting

You can use the sorting tool to more than alphabetize. Consider these convenient tips:

	 1. Use SORT to get rid of empty rows in between data. 

			   a.	 Select all columns containing data.

			   b.	 From the Standard toolbar, select Sort Ascending.

			   c.	 The empty rows will be sorted to the bottom.

	 2. Sort your month column in month order.

			   a.	 Select any cell in the month column.

			   b.	 From the Menu bar, select Data, Sort.

			   c.	 At the bottom left, select Options.

 

			   d.	 Select the months as your First key sort order.

			   e.	 Select OK.
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Subtotals

If you have two columns that need to be subtotaled (such as item quantity and dollar 
amount), you can perform both of these calculations using a single shortcut. 

	 1. Subtotal under more than one field.

			   a.	 Sort the fields which you need to have subtotaled. 

			   b.	 In the example (see screenshot), Customer Name and Area have been sorted.

 

			   c.	 Select Data then Subtotals.

			   d.	 Make the selection in the At each change in dropdown list  
				    (for example Customer Name).

			   e.	 In Add Subtotal to, select the Quantity and Total checkboxes.

			   f.	 Repeat steps c and d, and select Area.

			   g.	 Deselect the Replace current subtotals checkbox, and then select OK.
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